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Abstrak

Penelitian ini bertujuan untuk melihat pengaruh Visual, Vocal, dan Celebrity Effect yang terdapat dalam music video dan video performance BTS terhadap Destination Image serta Intention To Visit ke Korea Selatan. Penelitian ini merupakan penelitian berjenis kausal dengan menggunakan pendekatan kuantitatif. Penulis menggunakan teknik analisis data Partial Least Square (PLS). Penelitian ini juga menggunakan teori Stimulus Organism Response (SOR) untuk menganalisa pengaruh Visual, Vocal, dan Celebrity Effect terhadap Destination Image dan Intention To Visit. Penulis berhasil mendapatkan sebanyak 221 responden dan menemukan bahwa Visual Effect dan Vocal Effect memiliki pengaruh yang signifikan terhadap Destination Image yang kemudian mempengaruhi Intention To Visit ARMY Indonesia untuk berkunjung ke Korea Selatan. Sedangkan untuk Celebrity Effect tidak ditemukan pengaruh yang signifikan terhadap Destination Image Korea Selatan.
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Abstract

This study is causal-type research that uses a quantitative approach to see the impacts of Visual, Vocal, and Celebrity Effect in BTS music and performance videos on Destination Image and Intention To Visit South Korea. Researchers are using Partial Least Square (PLS) for the data analysis technique and Stimulus Organism Response (SOR) as the theory for analyzing the impacts of Visual, Vocal, and Celebrity Effect on Destination Image and Intention To Visit South Korea. Researchers were able to collect 221 respondents and found that Visual Effect and Vocal Effect are able to affect the Destination Image of South Korea significantly which then provokes their Intention To Visit South Korea, whereas Celebrity Effect doesn't have a significant effect on Destination Image.
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PENDAHULUAN
Korea Selatan telah menjadi salah satu destinasi yang paling diminati oleh para turis baik dari negaranya sendiri maupun dari internasional. Salah satu penyebab hal tersebut dapat terjadi adalah karena Korean Wave atau yang biasa juga disebut sebagai Hallyu, yang melingkupi film, drama, musik, selebriti, dan berbagai bentuk seni hiburan lainnya. Korea Selatan adalah satu-satunya negara di dunia yang berdedikasi untuk menjadi eksportir budaya populer (pop-culture) terkemuka di dunia (Roll, 2020). Pemerintah Korea mendukung menggunakan Hallyu dalam meningkatkan bidang pariwisata mereka dengan memakai artis-artis Hallyu sebagai media promosi. Hal ini mampu meningkatkan keinginan untuk mengunjungi Korea dan meningkatkan perhatian terhadap budaya Korea. Tidak hanya itu, kementerian Budaya, Olahraga dan Pariwisata Korea Selatan juga membawahi tiga lembaga yang bertanggung jawab untuk menyebarkan Hallyu ke luar negeri yaitu KOCCA (Korea Creative Content Agency), KOFICE (Korea Foundation for International Cultural Exchange), dan KTO (Korean Tourism Organization). Per Agustus 2020, Korean Culture and Information Service (KOCIS) telah mendirikan 32 Korean Culture Centers (KCC) di 28 negara dari benua Afrika, Asia, Eropa, dan Amerika untuk mempromosikan Hallyu (Roll, 2020).
Salah satu faktor pendorong terbesar dari Hallyu adalah K-Pop. Karena banyaknya grup musik Korea yang memperoleh popularitas menyebabkan bertambahnya minat wisatawan dari berbagai negara untuk merasakan dan mengalami budaya Korea secara langsung. Untuk itu, KTO juga menyediakan beberapa paket wisata yang mencakup destinasi-destinasi yang menarik bagi para pecinta K-Pop (Roll, 2020). Menurut badan yang dibawahi oleh Menteri Luar Negeri Korea Selatan, dalam K-Pop sendiri, boy group Bangtan Sonyeondan (BTS) telah menjadi faktor pendorong terkuat untuk mempromosikan Hallyu secara global (Heo, 2021). Hal ini didasarkan oleh survei online yang dilakukan oleh Korea Tourism Organization (KTO) pada 12.663 penggemar Hallyu di bulan Agustus hingga September tahun 2019. Hasil dari survei tersebut menemukan bahwa BTS merupakan artis K-Pop yang paling populer dan berpengaruh besar terhadap Hallyu menurut responden dengan persentase sebesar 36,1% (Bae, 2020).  Music streaming platform Spotify juga mengumumkan daftar artis yang paling banyak mendapatkan pendengar di Indonesia dan BTS menempati urutan pertama dalam daftar tersebut (Iskandar, 2020). Social media platform Twitter juga menganalisa hashtag dan mention terbanyak dalam kategori K-Pop dari periode 1 Juli 2019 - 30 Juni 2020. Berdasarkan data Twitter, artis K-Pop paling populer di Indonesia yang menduduki peringkat pertama adalah BTS (Hestianingsih, 2020). Selain itu, BTS juga merupakan Duta Pariwisata Kehormatan Seoul sejak tahun 2017.
Berdasarkan jurnal dari Rajaguru (2013), motion pictures memiliki tiga elemen yaitu Visual, Vocal, dan Celebrity. Ketiga elemen ini juga dapat diaplikasikan ke berbagai macam konteks penelitian lainnya, termasuk K-Pop. BTS sendiri dinilai memiliki ketiga elemen tersebut. Visual BTS dapat dilihat melalui video musik dan performance mereka. Vocal dapat diukur dari suara, melodi dan bahasa yang terdapat dalam lagu-lagu mereka. Celebrity dapat dilihat dari attractiveness, mampu merepresentasikan negara Korea Selatan, menarik, dan bagaimana selebriti tersebut mampu mengusung budaya Korea Selatan.
Dari ketiga elemen tersebut, BTS mampu untuk mempengaruhi Destination Image Korea Selatan, terbukti dari pengaruh besar BTS terhadap industri wisata Korea Selatan dan juga area kebudayaan lainnya. Melalui music video dan video performance, BTS telah menunjukkan berbagai lokasi indah di Korea Selatan yang belum banyak diketahui serta memperkenalkan budaya Korea Selatan kepada para penonton internasional. Setelah menonton music video dan video performance BTS, banyak penggemar yang merasa kagum atas keindahan lokasi yang digunakan sebagai tempat syuting (Heo, 2021). BTS juga mampu menunjukkan keindahan Korea Selatan yang terpancar melalui melodi dan lirik dari berbagai lagu mereka. BTS menggunakan kata “eolssu” dalam lirik chorus “IDOL” yang merupakan kata dukungan secara tradisional dan digunakan dalam pansori, sebuah gaya mendongeng tradisional ala Korea Selatan yang dilakukan secara musikal dan diiringi oleh musik drum (Gordon, 2019). BTS mempunyai daya tarik tersendiri yang mampu membuat para penggemarnya tertarik dengan ketujuh anggota BTS serta negara asal mereka. Contohnya dapat diambil dari ketampanan BTS saat menggunakan hanbok yang membuat para penonton di seluruh dunia kagum dengan keindahan pakaian tradisional Korea Selatan. Dengan memakai hanbok, BTS mengenalkan budaya Korea Selatan ke seluruh penggemarnya yang berasal dari berbagai negara (Fernandez, 2020). Dari fenomena-fenomena tersebut, BTS memenuhi ketiga elemen musik pop Korea yaitu Visual, Vocal, dan Celebrity yang mampu mempengaruhi image penggemarnya terhadap Korea Selatan.
Dengan adanya Destination Image yang baik terhadap negara Korea Selatan, hal ini menimbulkan Intention To Visit para penggemarnya ke Korea Selatan. Terbukti dari survei yang dilakukan oleh KTO pada tahun 2019 menunjukkan bahwa 5 lokasi wisata paling populer di Korea Selatan berhubungan dengan BTS (Kim, 2019). Pada tahun 2017, sebesar 7.6% dari total wisatawan berkunjung karena pengaruh dari BTS. Untuk itu, Seoul Metropolitan Government memberikan kredit kepada BTS karena telah membantu dalam memperbaiki industri wisata kota Seoul (Park, 2019). Maka dari itu, dapat dilihat bahwa pengaruh dari Destination Image yang dibentuk dan dipengaruhi oleh BTS diindikasikan mampu mempengaruhi Intention To Visit penggemarnya.
Penelitian mengenai K-Pop telah banyak dilakukan, namun penelitian mengenai Visual, Vocal, dan Celebrity sebagai karakteristik dari K-Pop serta pengaruhnya terhadap Destination Image dan Intention To Visit masih belum banyak ditemukan. Fenomena K-Pop, terutama BTS, saat ini semakin bertambah popularitasnya di seluruh dunia, termasuk Indonesia. Oleh karena itu, penulis tertarik untuk meneliti lebih dalam mengenai Visual, Vocal, dan Celebrity Effect dalam boyband BTS terhadap Destination Image dan Intention To Visit ke Korea Selatan dengan menggunakan teori Stimulus Organism Response (SOR). Penelitian ini diharapkan mampu menjadi referensi bagi penelitian selanjutnya yang ingin meneliti mengenai pengaruh pop-culture terhadap minat berkunjung wisatawan.

TEORI PENUNJANG DAN HIPOTESIS
Stimulus Organism Response
Teori Stimulus Organism Response (SOR) telah digunakan secara luas untuk menguji hubungan antara input (stimulus), proses (organism), dan output (response). Framework ini menunjukkan bahwa beberapa aspek lingkungan dapat memancing kondisi emosional dan kognitif seseorang, yang dapat menghasilkan suatu perilaku tertentu (Donovan & Rositer, 1982). Komponen pertama yaitu stimulus mengacu kepada faktor yang mempengaruhi keadaan internal dari seseorang dan dapat dikonseptualisasikan sebagai sebuah pengaruh yang menstimulasi individual tersebut (Eroglu, Machleit, & Davis 2001). Komponen kedua yaitu organism merujuk pada kondisi afektif dan kognitif seseorang, dimana elemen ini mengandung keseluruhan proses yang mengintervensi antara stimulus dengan response (Loureiro & Ribeiro, 2011). Kondisi afektif mengungkapkan perasaan dan emosi seseorang yang timbul atas adanya stimulus (Kamboj, Sarmah, Gupta, & Dwivedi, 2018). Sedangkan kondisi kognitif mencakup perolehan, pemrosesan, penyimpanan, dan pengambilan informasi yang dilakukan seseorang (Eroglu et al., 2001). Response dalam paradigma SOR merepresentasikan hasil akhir dan keputusan akhir dari konsumen, yang dapat berupa perilaku approach atau avoidance (Donovan & Rossiter 1982; Sherman, Mathur, & Smith 1997). 

Visual
Visual Effect mampu digunakan sebagai jendela untuk menjelajahi kondisi manusia secara lebih dalam (Wright, 2008). Diantara kelima indera manusia, penglihatan memiliki fitur pengenalan unik yang dapat mempengaruhi proses pengambilan keputusan konsumen, dan dapat diterima secara umum bahwa gambaran visual bertahan lebih lama dalam “black box” konsumen daripada gambaran verbal (Rajaguru, 2013). Dengan dukungan gambaran visual, media dapat menjadi faktor penarik untuk menciptakan kesadaran dan ketertarikan diantara wisatawan mengenai lokasi geografi dan wisata atraksi yang ditampilkan (Kim, 2012; Riley & Van Doren, 1992). Menurut Kim & Richardson (2003), mengamati dan berpartisipasi secara imajinatif dalam motion pictures mengaktifkan sistem proses informasi wisatawan dan memotivasi mereka untuk mengunjungi tempat atraksi wisatawan.

Vocal
Vocal terdiri dari musik dan bahasa dan efek dari vocal mampu menjadi keuntungan bagi pemasar wisata karena dapat digunakan sebagai media promosi wisata (Rajaguru, 2013). Musik dan lagu mampu menciptakan perasaan yang mengagumkan serta kenikmatan pada seseorang (Holbrook & Anand, 1990) dan telah dibuktikan secara eksperimen untuk mempengaruhi sikap dalam pengambilan keputusan (Kaltcheva & Weitz, 2006; Mattila & Wirtz, 2001). 

Celebrity
Selebriti dapat diklasifikasikan berdasarkan bidangnya seperti entertainers (aktor, model, pop-star, dsb.), atlet, pengusaha, atau politisi (Shimp, 2000). Selebriti memiliki kharisma, daya tarik, serta status sebagai role model yang dapat mempengaruhi para konsumen (Byrne, Whitehead, & Breen, 2003). Selain itu, selebriti dapat menjadi sebuah keunggulan dalam menciptakan suatu ketertarikan terhadap produk dan jasa yang digunakan (Schiffman & Kanuk, 2004). Oleh sebab itu, selebriti memegang peranan yang besar dalam pengambilan keputusan wisatawan mengenai destinasi wisata dan mampu mempengaruhi keputusan tersebut secara signifikan (Rajaguru, 2013).

Destination Image
Destination Image mengacu kepada sejumlah impresi, kepercayaan, pemikiran, persepsi, dan perasaan yang terbentuk dari waktu ke waktu terhadap suatu tempat (Assael 1984; Crompton 1979), dan berperan penting dalam berbagai proses pengambilan keputusan serta berpengaruh pada pengalaman yang dirasakan oleh wisatawan ketika berkunjung ke suatu destinasi (Chen & Tsai, 2007; Chon, 1991; Fakeye & Crompton, 1991; Gartner, 1994; Lee, Lee, & Lee, 2005). Impresi ini meliputi keseluruhan aspek destinasi, termasuk budaya, karakteristik alam dan sosialnya (Beerli & Martín, 2004).
Baloglu & McCleary (1998) mengatakan bahwa Destination Image adalah sebuah penilaian sikap evaluatif yang mengandung kedua elemen cognitive dan affective. Cognitive Destination Image terdiri dari kepercayaan dan pengetahuan mengenai atribut fisik suatu destinasi yang didasarkan atas informasi yang nyata (Papadimitriou et al., 2015; Whang et al., 2016), sedangkan affective Destination Image menekankan perasaan dan emosi yang seseorang ikatkan ke suatu destinasi (Baloglu & Brinberg, 1997; Papadimitriou et al., 2015).
 
Intention To Visit
Visit intention adalah kemungkinan yang dirasakan wisatawan untuk mengunjungi destinasi tertentu dalam periode tertentu (Ahn et al., 2013; Woodside & Lysonski, 1989). Oleh karena itu, untuk berkorelasi erat dengan perilaku perjalanan, Intention To Visit dianggap sebagai variabel penting dalam penelitian pariwisata dan perjalanan (Um & Crompton, 1992; Woodside & Lysonski, 1989). Intention To Visit juga dianggap sebagai proses mental dan transformasi motivasi perjalanan menjadi perilaku (Jang et al., 2009). Menurut Rajaguru (2013) Intention To Visit dipengaruhi oleh lingkungan internal dan eksternal yang mampu mempengaruhi keputusan seseorang untuk berkunjung serta bergantung pada ketertarikan wisatawan dengan destinasi wisata. 

Hubungan Antara Visual Effect dan Destination Image
Informasi visual sangat penting dalam pemasaran destinasi karena dapat menggambarkan keaslian dari tempat tersebut (Fakeye & Crompton, 1991). Hal ini dapat menyebabkan peningkatan terhadap familiaritas dengan suatu destinasi, yang kemudian berpengaruh terhadap Destination Image-nya (Baloglu, 2001; Fakeye & Crompton, 1991). Penggunaan motion pictures sebagai media promosi telah terbukti sebagai salah satu media promosi paling sukses dalam meningkatkan kesadaran wisatawan karena dapat secara eksplisit menyajikan gambaran visual dari atraksi wisata (Blech & Blech, 2001). Meskipun membujuk audiens untuk mengunjungi lokasi yang  ditampilkan dalam motion pictures bukan merupakan tujuan utama sebagian besar produser film, namun pemandangan indah, landscape, gaya hidup, dan cultural experience yang ditampilkan dalam motion pictures dapat meningkatkan awareness dan perasaan familiar audiens terhadap lokasi yang ditayangkan, mengubah dan membentuk suatu image terhadap destinasi, serta mempengaruhi dalam pengambilan keputusan sebagai turis (Lee, Ham, & Kim, 2015; Wen, Josiam, & Spears, 2018). Motion pictures dalam konteks K-Pop dapat berupa music video, video performance, iklan, acara TV, dan lain sebagainya.
H1: Visual Effect dalam musik pop Korea berpengaruh terhadap Destination Image Korea Selatan

Hubungan Antara Vocal Effect dan Destination Image
Pop-culture, terutama yang mengandung musik dan lagu, memiliki hubungan yang erat dengan Destination Image (Kim et al., 2020). Musik dapat digunakan sebagai alat promosi dalam menciptakan image suatu tempat untuk tujuan pemasaran pariwisata (Lee et al., 2015). Lagu dan ritme bahasa berperan secara dominan dalam menciptakan suatu Destination Image (Rajaguru, 2013). Dengan meningkatnya popularitas K-Pop, membuat Korea Tourism Organization (KTO) menggunakan pengaruh vokal mereka untuk memasarkan pariwisata Korea Selatan. Wisatawan juga dapat timbul rasa keterikatan dan ketertarikan terhadap suatu destinasi karena terdapat relasi antara destinasi dengan faktor-faktor yang berkaitan dengan musik, diantaranya adalah tempat penampilan, tempat dalam lirik lagu, dan tempat kelahiran atau kematian seorang musisi (Gibson & Connell, 2007). Musik dan lagu dari musisi juga dapat mempengaruhi pandangan seseorang terhadap suatu destinasi, misalnya sebagai tempat untuk menghadiri konser (Kim et al., 2008).
H2: Vocal Effect dalam musik pop Korea berpengaruh terhadap Destination Image Korea Selatan

Hubungan Antara Visual Effect dan Destination Image
Celebrity merupakan salah satu komponen pop-culture yang dapat dikatakan kuat karena memiliki paling banyak penggemar (Lee et al., 2015). Berbagai anekdot dan pengamatan yang ada pada media massa mendukung pandangan bahwa keterlibatan seseorang dengan selebriti biasanya dapat memicu minat mereka terhadap negara asal selebriti tersebut, meningkatkan citra negara tersebut, dan akhirnya menimbulkan minat untuk mengunjungi negara tersebut (Lee et al., 2008). Ketertarikan yang tinggi terhadap selebriti Korea Selatan menyebabkan perubahan persepsi wisatawan global terhadap Korea Selatan (Lee & Bai, 2010). Tren baru dan terkini yang digambarkan oleh selebriti Korea Selatan dapat memproyeksikan Destination Image Korea Selatan, dan karena gambaran tersebut, masyarakat di negara yang mengalami Hallyu menganggap Korea Selatan sebagai negara yang maju dan modern (Sung, 2010). 
H3: Celebrity Effect dalam musik pop Korea berpengaruh terhadap Destination Image Korea Selatan

Hubungan Antara Destination Image dan Intention To Visit
Destination Image memiliki peran yang penting dalam proses pengambilan keputusan wisatawan, dan destinasi dengan image yang lebih kuat dan positif akan lebih memungkinkan untuk dipilih (Beerli & Martin, 2004; Chen & Tsai, 2007; Kanwel et al., 2019; Liu et al., 2015; Woodside & Lysonski, 1989). Menurut Iwashita (2006), wisatawan akan memutuskan untuk mengunjungi suatu negara karena sikap positif yang mereka miliki terhadap pengetahuan mengenai bangsa, alam, budaya, dan masyarakat negara tersebut. Maka dari itu, dapat dikatakan bahwa Destination Image merupakan prediktor yang signifikan dari pemilihan destinasi dan Intention To Visit (Tan & Wu, 2016). Penelitian sebelumnya menyatakan adanya hubungan positif dan signifikan antara Destination Image dengan Intention To Visit (Chalip et al., 2003; Lupton, 1997; Woodside & Lysonski, 1989).
H4: Destination Image berpengaruh terhadap Intention To Visit ke Korea Selatan

METODE PENELITIAN
Penelitian ini memakai pendekatan kuantitatif kausal serta menggunakan metode survei dengan kuesioner sebagai media untuk mengumpulkan data. Pengambilan sampel dilakukan dengan menggunakan teknik sampling non probability dengan model purposive sampling dimana kriteria yang ditentukan adalah responden berusia 17-30 tahun, berprofesi sebagai, pelajar SMA, mahasiswa aktif, fresh graduate S-1, pegawai profesional, wiraswasta, ibu rumah tangga, atau pekerjaan lainnya, tergabung dalam komunitas online ARMY BTS di Instagram dan Twitter dan pernah mendengar lagu-lagu atau melihat video musik BTS (Spotify, Apple Music, Youtube, V LIVE, dan SoundCloud) dalam 6 bulan terakhir. Dalam penelitian ini, penulis menyebarkan kuesioner secara online melalui google form. Dari 317 responden yang diperoleh, terdapat 45 responden yang tidak mampu memenuhi kriteria serta 51 responden yang tidak valid, sehingga hanya 221 kuesioner yang dapat diolah untuk penelitian lebih lanjut. Penelitian ini menggunakan skala Likert yang mempunyai tingkat pengukuran dari 1 (sangat tidak setuju) sampai dengan 5 (sangat setuju). Pengujian hipotesis dalam penelitian ini menggunakan analisa multivariat dengan teknik Structural Equation Modelling (SEM) berbasis varian atau Partial Least Square (PLS) serta software SmartPLS. Adapun model penelitian dapat dilihat pada Gambar 1 dibawah ini.
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Gambar 1. Direct Path of The Structural Model

HASIL DAN PEMBAHASAN
Profil Responden
Mayoritas dari responden memiliki jenis kelamin perempuan dengan jumlah responden sebesar 218 (98.64%), sementara itu responden dengan jenis kelamin pria hanya berjumlah 3 (1.36%). Usia dari para responden sebagian besar adalah 17-19 tahun dengan jumlah responden sebesar 97 (43.89%), sedangkan yang berusia 20-22 tahun berjumlah 60 responden (27.15%), 23-25 tahun berjumlah 32 responden (14.48%), dan 26-30 tahun berjumlah 32 (14.48%). Profesi yang dimiliki oleh responden sebagian besar adalah mahasiswa aktif S-1 dengan jumlah responden sebesar 82 (37.10%), sedangkan responden dengan profesi pelajar (SMA) berjumlah 60 (27.15%), fresh graduate S-1 berjumlah 8 (3.62%), pegawai profesional berjumlah 24 (10.86%), wiraswasta berjumlah 20 (9.05%), ibu rumah tangga berjumlah 9 (4.07%), dan yang lain-lain berjumlah 18 (8.15%). Pengeluaran yang dihabiskan para responden per bulan mayoritas sebesar Rp 1.000.000 - Rp 5.000.000 dengan jumlah responden sebesar 199 (80%), kemudian Rp 5.000.000 - Rp 10.000.000 berjumlah 10 responden (15%), dan >Rp 10.000.000 dengan berjumlah 12 responden (5%). 

Analisa Statistik Deskriptif
Dari Tabel 1 dapat dilihat bahwa dalam variabel Visual Effect, menunjukkan kehidupan malam yang berwarna memiliki nilai mean tertinggi (4.837) yang berarti para responden memiliki Destination Image yang baik setelah melihat video musik dan performance BTS yang menunjukkan kegiatan konser mereka. Dalam variabel Vocal Effect, nilai mean tertinggi adalah kagum dengan musik Korea (4.810) yang menunjukkan bahwa musik BTS dalam video musik dan performance mereka membuat para responden memiliki Destination Image Korea Selatan yang positif. Sedangkan dalam variabel Celebrity Effect, menarik perhatian memiliki mean tertinggi (4.959). Hasil ini menunjukkan bahwa Destination Image para responden cenderung terbentuk karena daya tarik BTS dalam video musik dan performance mereka. Untuk Destination Image, pemandangan alam indah Korea Selatan memiliki mean tertinggi (4.439) diikuti dengan daya tarik budaya yang menarik (4.403) dan daya tarik sejarah yang menarik (4.113). Hal ini menyatakan bahwa dari video musik dan performance BTS, para responden memandang bahwa Korea Selatan menawarkan banyak pemandangan alam yang indah. Untuk Intention To Visit, motivasi untuk berkunjung memiliki mean tertinggi (4.448) diikuti dengan berangan-angan untuk berkunjung (4.674) dan mencari informasi lebih (4.054). Hasil tersebut menunjukkan bahwa setelah Destination Image Korea Selatan dari video musik dan performance BTS terbentuk, para responden cenderung termotivasi untuk pergi berkunjung ke Korea Selatan. Hasil dari mean dan standar deviasi dari Visual Effect, Vocal Effect, Celebrity Effect, Destination Image, dan Intention To Visit dapat dilihat pada Tabel 1.

Tabel 1. Hasil Mean dan Standar Deviasi
	No.
	Pernyataan
	Mean
	Standar Deviasi

	Visual Effect
	4.770
	0.492

	VI1
	Saya menyukai pinggiran kota Korea Selatan yang indah yang ditampilkan di video musik atau performance BTS
	4.756
	0.507

	VI2
	Saya menyukai penempatan kota-kota di Korea Selatan yang terlihat hidup dalam video musik atau performance BTS
	4.783
	0.528

	VI3
	Menurut saya Korea Selatan adalah tempat yang menarik untuk dikunjungi
	4.706
	0.529

	VI4
	Saya senang dengan kehidupan malam yang berwarna di Korea Selatan yang ditampilkan dalam video musik atau performance BTS
	4.837
	0.404

	Vocal Effect
	4.731
	0.509

	VO1
	Saya mengagumi ritme (intonasi, pelafalan, dll) dalam bahasa Korea yang ditampilkan di video musik atau performance BTS
	4.674
	0.532

	VO2
	Saya kagum dengan musik Korea yang ditampilkan di video musik atau performance BTS
	4.810
	0.426

	VO3
	Saya selalu ingin mendengarkan musik Korea yang ditampilkan di video musik atau performance BTS
	4.710
	0.569

	Celebrity Effect
	4.878
	0.373

	CE1
	BTS menarik perhatian saya
	4.959
	0.219

	CE2
	Saya melihat BTS sebagai citra negara Korea Selatan
	4.801
	0.472

	CE3
	BTS membuat musik Korea menjadi lebih menarik
	4.864
	0.446

	CE4
	Saya kagum dengan BTS yang mengusung budaya Korea Selatan dalam video musik atau performance mereka
	4.887
	0.357

	Destination Image
	4.090
	0.746

	DI1
	Korea Selatan menawarkan banyak pemandangan alam yang indah
	4.439
	0.640

	DI2
	Korea Selatan memiliki daya tarik budaya yang unik
	4.403
	0.642

	DI3
	Korea Selatan memiliki daya tarik sejarah yang menarik
	4.113
	0.796

	DI4
	Korea Selatan merupakan negara yang menyenangkan
	4.027
	0.807

	DI5
	Korea Selatan merupakan negara yang tenang (damai dan tenteram)
	3.538
	0.793

	DI6
	Korea Selatan merupakan negara yang mengasyikkan (seru, tidak monoton, sensasional)
	4.023
	0.798

	Intention To Visit
	4.392
	0.707

	IV1
	Saya akan mencari informasi lebih lanjut mengenai Korea Selatan
	4.054
	0.759

	IV2
	Saya memiliki motivasi yang kuat untuk mengunjungi Korea Selatan
	4.448
	0.775

	IV3
	Saya berangan-angan untuk mengunjungi Korea Selatan
	4.674
	0.589



Measurement Model
Berdasarkan Tabel 2, dapat dilihat bahwa semua nilai AVE dari variabel Visual Effect, Vocal Effect, Celebrity Effect, Destination Image, dan Intention To Visit telah memenuhi syarat dari convergent validity yang harus berkisar antara 0.5 atau lebih dari 0.5. Indikator dalam uji discriminant validity terbukti valid karena hasil validitas diskriminan dari setiap indikator terhadap variabelnya lebih tinggi dibandingkan dengan nilai korelasi terhadap variabel lainnya. Sedangkan hasil uji Cronbach’s Alpha dari variabel Visual Effect, Vocal Effect, Celebrity Effect, Destination Image, dan Intention To Visit menunjukkan nilai diatas 0.6 sehingga dapat dikatakan reliabel. Kemudian, composite reliability harus lebih besar dari 0.7 dan semua variabel menunjukkan nilai diatas 0.7 yang berarti dapat dikatakan reliabel. 

Tabel 2. AVE, Cronbach’s Alpha, Composite Reliability

	Variabel
	AVE
	Cronbach’s Alpha
	Composite Reliability

	Vocal Effect
	0.555
	0.620
	0.788

	Visual Effect
	0.698
	0.782
	0.874

	Celebrity Effect
	0.577
	0.644
	0.804

	Destination Image
	0.556
	0.840
	0.882

	Intention To Visit
	0.637
	0.726
	0.840



Structural Model
	Nilai R-square dari variabel Destination Image sebesar 0.318 yang berarti Destination Image dapat dijelaskan sebesar 31.8% oleh variabel Visual Effect, Vocal Effect, Celebrity Effect. Nilai R-square dari variabel Intention To Visit sebesar 0.277 yang berarti Intention To Visit dapat dijelaskan sebesar 27.7% oleh variabel Destination Image.
	Kesesuaian model diuji dengan cara melakukan pengujian Q-square yang dilakukan untuk mengukur seberapa baik nilai observasi atau relevansi prediksi yang dihasilkan oleh suatu model. Nilai Q-square yang didapatkan untuk Destination Image adalah sebesar 0.168 dan untuk Intention To Visit adalah sebesar 0.518 yang menunjukkan bahwa model penelitian ini memiliki predictive relevance dan layak untuk digunakan. Tabel 3 dibawah ini menunjukkan hubungan kausal antara Visual Effect, Vocal Effect, Celebrity Effect, Destination Image, dan Intention To Visit.

Tabel 3. Analisa Path Coefficients
	
	Hipotesis
	Path Coefficient
	T-value
	Hasil Hipotesis

	H1:
	Visual Effect -> Destination Image
	0.325
	5.332
	Diterima

	H2:
	Vocal Effect -> Destination Image
	0.308
	4.971
	Diterima

	H3:
	Celebrity Effect -> Destination Image
	0.032
	0.400
	Tidak diterima

	H4:
	Destination Image -> Intention To Visit
	0.526
	10.258
	Diterima



Pengaruh Visual Effect terhadap Destination Image
	Dari Tabel 3 dapat dilihat bahwa Visual Effect berpengaruh signifikan terhadap Destination Image sehingga H1 dalam penelitian ini diterima. Video musik atau performance BTS mampu memperlihatkan pemandangan, keadaan, dan suasana di Korea Selatan dengan baik. Visual Effect setelah melihat video musik atau performance tersebut mampu membuat para penontonnya mengetahui akan keindahan dari tempat-tempat yang ada di Korea Selatan. Dari pengetahuan tersebut, para penonton memiliki Destination Image yang baik terhadap Korea Selatan. Hasil penelitian ini didukung oleh penelitian oleh Lee, Ham, & Kim (2015) yang menyatakan bahwa visual image yang ditampilkan mengenai Korea Selatan, dalam penelitian ini melalui film dan drama TV, dapat membentuk Destination Image dengan lebih baik.

Pengaruh Vocal Effect terhadap Destination Image
	Hasil dari penelitian ini menunjukkan bahwa Vocal Effect berpengaruh signifikan terhadap Destination Image, maka dari itu H2 diterima. Pada variabel Vocal Effect, indikator yang paling menggambarkan adalah VO2 yaitu "Saya kagum dengan musik Korea yang ditampilkan di video musik atau performance BTS". Selain itu, Vocal Effect mampu membantu audiens BTS membentuk Destination Image karena adanya penggunaan lirik dalam bahasa Korea serta musik tradisional Korea dalam lagu-lagu BTS. BTS seringkali menggunakan lirik bahasa Korea yang mengandung unsur budaya dan sastra di dalamnya, membuat penggemarnya harus mempelajari konteks di balik liriknya untuk mengerti dengan jelas makna dari lagu-lagunya. Hal ini membuktikan bahwa setelah melihat dan mendengar video musik atau performance tersebut para audiensnya kagum dengan keindahan dari ritme, intonasi, pelafalan bahasa Korea dan musik Korea Selatan dan kemudian audiens mampu membentuk Destination Image yang positif terhadap Korea Selatan. Hasil penelitian ini sejalan dengan penelitian sebelumnya yang menemukan bahwa musik, terlebih melalui lirik, dapat membentuk Destination Image wisatawan baik secara fisik maupun perasaan (Gibson & Connell, 2007). 

Pengaruh Celebrity Effect terhadap Destination Image
Hasil penelitian menunjukkan bahwa Celebrity Effect tidak berpengaruh terhadap Destination Image, oleh sebab itu H3 ditolak. Hasil total dari mean pernyataan mengenai variabel Celebrity Effect dan Destination Image sebenarnya memiliki nilai yang tergolong sangat tinggi dan tinggi (dapat dilihat pada Tabel 1), yang menunjukkan bahwa responden setuju serta memberikan tanggapan yang baik terhadap pernyataan pada variabel Celebrity Effect dan Destination Image. Namun setelah dilakukan uji pengaruh secara statistika, hasil menunjukkan pengaruh tidak signifikan dari Celebrity Effect boyband BTS terhadap Destination Image Korea Selatan. Hal ini disebabkan oleh pergerakan varians yang diuji cobakan tidak konsisten yang akhirnya membuat pengaruhnya menjadi tidak signifikan.
Hal ini dapat dikarenakan oleh jarak yang jauh antara Korea Selatan dengan Indonesia, karena jarak geografis mempengaruhi pembentukan Destination Image (Lee et al., 2008). Semakin jauh jarak geografis, wisatawan cenderung memiliki image yang kurang solid tentang suatu destinasi karena terbatasnya peluang untuk memiliki first-hand dan second-hand experience dengan destinasi tersebut (Lee et al., 2008). Dalam konteks ini, kemajuan teknologi berperan besar dalam menghubungkan artis mancanegara dengan penggemarnya. Namun, masih banyak keterbatasan yang mungkin dapat menyebabkan pengaruh selebriti terhadap Destination Image tidak signifikan. Selain itu, penulis juga menduga hal ini disebabkan oleh para penggemar K-Pop yang sudah tidak asing dengan kerasnya kehidupan idol di Korea Selatan seperti persaingan yang ketat, jadwal yang padat, tuntutan pekerjaan, tekanan fisik dan mental, dan lain sebagainya. Hal ini dapat menimbulkan pandangan yang kurang baik terhadap Korea Selatan sehingga dapat mempengaruhi persepsi para responden ketika mengisi pernyataan-pernyataan kuesioner pada variabel Celebrity Effect dan Destination Image. Hasil penelitian ini sejalan dengan penelitian sebelumnya yang dilakukan oleh Lee, Scott, & Kim (2008) dimana penelitian tersebut juga tidak menemukan pengaruh langsung dari selebriti terhadap Destination Image.

Pengaruh Destination Image terhadap Intention To Visit
Berdasarkan hasil penelitian, dapat diketahui bahwa Destination Image berpengaruh signifikan terhadap Intention To Visit. Hal ini membuktikan bahwa Destination Image yang terbentuk dari Visual Effect dan Vocal Effect video musik atau performance BTS mampu membuat para ARMY di Indonesia tertarik dengan Korea Selatan dan menimbulkan keinginan untuk mengunjungi Korea Selatan. Indikator yang paling menggambarkan variabel Destination Image adalah DI1 yaitu "Korea Selatan menawarkan banyak pemandangan alam yang indah". Para ARMY Indonesia memiliki pandangan bahwa Korea Selatan memiliki pemandangan alam yang indah dikarenakan oleh video musik dan performance BTS sehingga menimbulkan minat mereka untuk berkunjung ke Korea Selatan. Penelitian ini sejalan dengan penelitian Iwashita (2006), Chaulagain et al. (2019), Chen & Tsai (2007), Tan & Wu (2016), Kanwel et al. (2019), dan Afshardoost & Eshagi (2020) yang menemukan adanya pengaruh positif antara Destination Image dengan Intention To Visit. Tan & Wu (2016) menyatakan bahwa Destination Image merupakan prediktor yang signifikan dari behavioral intentions seperti pilihan destinasi dan Intention To Visit.

SIMPULAN DAN SARAN
	Berdasarkan dari hasil dan pembahasan diatas, dapat disimpulkan bahwa Visual Effect dan Vocal Effect berpengaruh signifikan terhadap Destination Image. Semakin video musik dan performance BTS mampu menunjukkan keadaan dan suasana Korea Selatan serta mengandung bahasa dan musik Korea Selatan, semakin positif juga Destination Image ARMY di Indonesia terhadap Korea Selatan. Sedangkan hasil dari Celebrity Effect tidak menemukan adanya pengaruh signifikan terhadap Destination Image. Semakin video musik dan performance BTS menunjukkan pesona member-member BTS yang menarik, hal tersebut tidak menjamin akan terbentuknya Destination Image ARMY di Indonesia terhadap Korea Selatan. Selain itu, penelitian ini juga menunjukkan bahwa Destination Image berpengaruh signifikan terhadap Intention To Visit. Artinya, semakin ARMY di Indonesia memiliki Destination Image yang positif terhadap Korea Selatan, semakin tinggi juga Intention To Visit mereka untuk berkunjung ke Korea Selatan. 
Dari hasil penelitian ini, terdapat beberapa hal yang bisa diterapkan oleh industri pariwisata di Indonesia agar membuat Destination Image yang positif serta meningkatkan Intention To Visit seseorang untuk mengunjungi tempat-tempat pariwisata di Indonesia. Kementerian Pariwisata dan Ekonomi Kreatif Republik Indonesia (Kemenparekraf RI) dapat bekerja sama dengan industri entertainment di Indonesia untuk meningkatkan Visual Effect dalam video musik dan performance penyanyi-penyanyi Indonesia kedepannya untuk seperti menunjukkan pinggiran kota yang indah, meningkatkan jumlah dan lokasi kota-kota metropolitan di Indonesia yang menjadi pusat bisnis atau budaya sebagai latar belakang, ataupun menampilkan aktivitas dan gaya hidup Indonesia seperti kuliner makanan khas Indonesia. Hal tersebut mampu membentuk Destination Image yang positif pada para audiens. Kemudian, industri entertainment Indonesia juga dapat menambah penggunaan alat musik tradisional dan menggunakan lirik yang menggambarkan isu sosial dan prinsip hidup orang Indonesia dalam produksi lagu atau video musik dan performance penyanyi-penyanyi Indonesia agar para audiens termotivasi untuk mengunjungi Indonesia.
	Penelitian ini hanya berfokus pada komunitas ARMY di Indonesia sehingga tidak dapat melihat varian hasil lainnya secara umum. Maka dari itu, pada penelitian selanjutnya diharapkan penulis dapat memperluas sampel dengan menentukkan sampel yang lain, contohnya seperti masyarakat umum. Penelitian selanjutnya juga diharapkan untuk dapat memfokuskan pada jenis sampel yang lebih spesifik seperti ARMY di Surabaya dan meningkatkan jumlah sampel untuk memastikan prediksi pengaruh antar variabel yang lebih konsisten. Penelitian selanjutnya dapat menggunakan variabel mediasi antara Celebrity Effect dengan Destination Image untuk melihat lebih jelas pengaruh dari celebrity terhadap image suatu tempat. Contohnya dengan menggunakan variabel celebrity worship dan familiarity. Jika ingin melakukan penelitian menggunakan variabel yang sama, penulis dapat meneliti selebriti lainnya. Contohnya seperti NCT, Blackpink, TWICE, Stray Kids, IU yang berasal dari Korea Selatan ataupun selebriti dari negara lain.
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